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LEZIONE 2 

GESTIONE NUVOLA DI PUNTI IN CLOUDCOMPARE 
In questo esercizio useremo il software libero CloudCompare, scaricabile gratuitamente al seguente link: 

https://www.danielgm.net/cc/, progettato per visualizzare e gestire nuvole di punti. 

 

Dati LIDAR Piano Straordinario Telerilevamento: 

• Quadri d’uninone aree disponibili http://www.pcn.minambiente.it/viewer/  

• Richiesta dei dati http://www.pcn.minambiente.it/mattm/servizio-distribuzione-dati-pst/ 

Nel software CloudCompare, andremo ad analizzare la nuvola di punti e costruire un modello digitale del terreno 

(DTM). 

1) Operazioni preliminari 

a) Caricare il file POINTCLOUD_lidar_raw_areastudio  in cloud compare:  

b) Appare con due colori, così come il dato è classificato 

c) filtrare NUVOLA INTERA:  

d) Selezionare il layer nella lista 

e) utilizzare il seguente comando per eseguire il filtraggio  

f) Nella finestra, selezionare 1.5 e successivamente SPLIT 

 
g) Nella lista layer, rinominare xxx.outside come OUTSIDE 

h) Nella lista layer, rinominare xxx.extract come TERRAIN 

i) Salvare la nuvola filtrata (solo terreno) in formato LAS 

i. selezionare la nuvola TERRAIN_STUDY_AREA 

ii.  salvare come TERRAIN_STUDY_AREA.las 

iii. Importante:  

 

2) Calcolo della mesh (LA MESH NON E’ UN MODELLO DIGITALE DEL TERRENO! Serve per esplorare la 

morfologia 

a) Calcoliamo la mesh, per capire la morfologia del terreno 

b) selezionare TERRAIN 

https://www.danielgm.net/cc/
http://www.pcn.minambiente.it/viewer/
http://www.pcn.minambiente.it/mattm/servizio-distribuzione-dati-pst/
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c) , settare i seguenti parametri, facendo UPDATE GRID dopo aver selezionato 1, per poi cliccare 

su MESH:  

 

d) Selezionare TERRENO.mesh nella lista layer 

e) Nei comandi a tendina in alto: EDIT -> Normals -> Compute -> Per-Vertex 

FATTO! La mesh è utile per osservare in 3D la nostra area di studio 

 

 

2) Creazione del DTM 

a) selezionare TERRAIN 

b) , settare i seguenti parametri, facendo UPDATE GRID dopo aver selezionato 1, per poi cliccare su 

RASTER:  

c)  

d) Export heights  

e) Salvare il DTM come DTM.tif 

FATTO! 
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Come sono le nuvole di punti costruite con drone e fotogrammetria? 

Importa POINTCLOUD_UAV_raw.las 

 

 

PRE-FILTRAGGIO 

SOR FILTER 

Tool > Clean > SOR fiter. Filtro statistic che permette di pulire la nuvola eliminando punti isolati 

 

FILTRAGGIO 

CSF FILTER 

Plug-in > CSF Filter 

  

Provare con Steep Slope + Slope Processing + Cloth: 0.3 (il resto come di default) 

 

UTILIZZO DELLA MESH 

Calcolo della distanza tra mesh e punti. 
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SEGMENTAZIONE 

Proviamo su un pezzetto di nuvola 

 

 

Tools > Segmentation > Cross Section 

1. Usare le frecce per regolare il box, in modo che contenga la nuvola 

 
2. Selezionare la larghezza del box in modo da creare una striscia (es: 5 m) 
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3. Vediamo che ora ho generato diverse slices 

 
4. Ora non resta che pulire che singole strisce! 
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OPERAZIONI PRELIMINARI IN QGIS 
Installare QGis versione LONG RELEASE  

Una volta installato QGis: 

1) Aprire il software QGis > Salvare il progetto con project – Save As. Chiamare il progetto hydrology.QGZ 

 

2) Project – Properties > CRS > scrivere nella ricercar 32632 > selezionare > ok 

 
 

3) Installare il plugin QuickMapServices per avere le Basemap 

 

a. Nel menu in alto, Processing > Toolbox (così compare a destra la barra con gli strumenti) 
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PROCESSI IDROGEOLOGICI: AREA DRENATA 
1) Trascinare in QGis il DTM: LIDAR_DTM_1m.tif 

 

 

2) Calcoliamo l’ombreggiatura (hillshade) per osservare la morfologia:  

a. A destra, nella barra processing scrivere “Hillshade” e selezionarlo nell’elenco 

b. In input scegliere il raster del DTM 

c. Salvare il file in una cartella come hillshade.tif 

 

 

3) Depittare il DTM (ovvero togliere eventuali “buchi”) per rendere il modello digitale idrologicamente corretto. I 

file sono salvati in un formato raster chiamato .sdat.  

a. Terrain analysis – Preprocessing > Fill sinks (Wang & Liu). Scegliere il DTM come input e salvare il file come 

DTM_fill.sdat in una cartella 
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Se il file non si aggiunge automaticamente alla mappa, trascinarlo in QGis manualmente dalla cartella 

 

 

 

4) Mappatura del deflusso superficiale 

 

IN QGIS 3.22 LTR 

a. SAGA >Terrain analysis – Hydrology > Flow accumulation (Top-Down) 

b. Come elevation scegliere il DTM (non l’ombreggiatura) 

c. Come metodo scegliere [3] Deterministic Infinity (Tarboton, 1997) 

d. Lasciare la spunta in Prevent Negative Flow Accumulation 

e. Salvare SOLO l’output “Flow Accumulation” 

f. Lasciare tutti gli altri parametri di default! 

g. Togliere la spunta a tutti gli altri output! 
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Fatto! Ma per capire il processo bisogna tematizzarlo 

 
 

a. Tasto dx sul layer > Proprietà > Simbology > Render type: Singleband Pseudocolor > Min: 0; Max: 

3000 > Interpolation: linear > Scegliere una scala colori dall’elenco > cliccando sui singoli colori di 

classi, si può modificare il colore: scegliere colore trasparente per la prima classe >  Modo: 

continuous (5 classi) >  OK 
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b. Aggiungo una basemap di Google: Web (dal menu in alto) > QuickMapService > Google > Satellite 

(NOTA: se non c’è Google,  QuickMapService > settings > More services > GET 
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NOTA SULLA SIMBOLOGIA DEI RASTER IN QGIS: 

• Ottenere varie scale colore per il raster: 

•  

 
• Qui troviamo una serie molto ampia di scale colore 
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PROCESSI IDROGEOLOGICI: RPII 
RPII (Tarolli et al., 2013) è calcolato con la seguente formula: 

 

Dove Ar è l’area drenata del DTM originale (già calcolata e chiamata flowAccumulation.sdat) con l’area drenata di 

un DTM smooth. 

 

a. Smooth del DTM: 

a) GRASS > Raster (r.*) > r.neighbors 

b) Selezionare il DTM come input e un kernel di 41 celle (è comunemente usato in caso di aree terrazzate) 

 

NB: cambiare la simbologia per visualizzare il risultato! 

 

ALTERNATIVA: 

Usare Focal Statistic (potrebbe metterci un pò di tempo).  

 

b. Calcolo area drenata sul DTM smooth 

a) Importare il file DTM_smooth_k41 

b) Terrain analysis – Preprocessing > Fill sinks (Wang & Liu). Scegliere il DTM come input e salvare il file come 

fill_DTM_smooth.sdat in una cartella 

c) SAGA >Terrain analysis – Hydrology > Flow accumulation (Top-Down). Creare il raster 

flow_Acc_DTM_smooth.sdat 

c. Ora passiamo al calcolo dell’RPII vero e proprio, utilizzando il calcolatore raster 

a) Raster > Raster calculator e inserire la formula: 

ln ( ("flow_Acc@1"-"flow_Acc_DTM_smooth@1")/ "flow_Acc_DTM_smooth@1") 
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Salvare il risultato come RPII.tif 

 
b) FATTO! Ora dobbiamo tematizzarlo 

 
c) Nelle proprietà del layer RPII.tif > information > leggere la deviazione standard: nel nostro caso è 2. La 

deviazione standard la usiamo per riclassificare il raster RPII secondo la seguente legenda (dove sigma = 

deviazione standard = 2) 

  
d) In symbology > Singleband pseudocolor > discrete > scegliere 6 classi > nella tabella valori mettere i 

multipli di deviazione standard > inserire etichetta come da screenshot > cambiare manualmente i colori 

(la prima classe colore trasparente) 
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e) FATTO: 
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TOPOGRAPHIC WETNESS INDEX (TWI) 
 

 

Dove a = l’area drenata a monte; b = pendenza (espressa in radianti) 

L' indice di umidità topografica ( TWI ) è un indice di umidità. L'indice è funzione sia della pendenza che dell'area 

contribuente a monte. Maggiore è il valore di indice, maggiore è la probabilità di accumulo di acqua (umidità), ma 

anche profondità del suolo, presenza di materiale fine (limo) e contenuto di materia organica. 

 

L’indice è calcolato a partire dal DTM. 

1. Calcolo della slope (in radianti) 

a. SAGA > Terrain Analysis Morphometry > Slope,Aspect,Curvature 

b. Elevazione: DTM 

c. Metodo: mettiamo il numero 8 (che è il più aggiornato) 

d. Unità: radianti 

e. Salviamo solo l’output Slope nella cartella 

 
2. Calcolo la flow accumulation (o contributing Area) 

a. SAGA >Terrain analysis – Hydrology > Flow accumulation (Top-Down) 

b. Come elevation scegliere il DTM (non l’ombreggiatura) 

c. Come metodo scegliere [3] Deterministic Infinity (Tarboton, 1997) 

d. Lasciare la spunta in Prevent Negative Flow Accumulation 

e. Salvare SOLO l’output “Flow Accumulation” 

f. Lasciare tutti gli altri parametri di default! 

g. Togliere la spunta a tutti gli altri output! 
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3. Calcolo del TWI, utilizzando il raster calculator 

a. Immettere: 

b. ln ( ( "FlowAccumulation@1") / tan("slope_rad@1")) 

 
c. Tematizzare il raster: 

d.  

FATTO!  
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MAPPATURA EROSIONE DEL SUOLO – Modello RUSLE 
Download dati a scala europea: https://esdac.jrc.ec.europa.eu/content/soil-erosion-water-rusle2015 

 

PARAMETRO 1 – EROSIVITA’ DELLA PIOGGIA (R) 

Dato climatico offerto dall’ESDAC. Raster già disponibile nei dati. 

 

PARAMETRO 2 – ERODIBILITA’ DEL TERRENO (K) 

Dato che si può ricavare da alcune carte di suolo. Ai fini di questo esercizio, il raster è già disponibile. Per la 

regione Veneto, vedi riquadro in basso. 

 

PARAMETRO 3 – FATTORE TOPOGRAFICO (LS) 

1. Importare il DTM presente nella cartella DATI 

2. Calcolo di LS: 

a. Saga > Terrain Analysis-Hydrology > LS-Factor, Field Based 

b. Impostare il DTM come Elevazione 

c. Come tipo di pendenza scegliere (0) local slope 

d. Lasciare tutto il resto  

e. Salvare solo LS factor nella cartella 

 

PARAMETRO 5 – FATTORE COPERTURA DEL SUOLO (P) 

Parametro disponibile tra i dati. Per il Veneto, vedi riquadro in basso. 

 

PARAMETRO 5 – FATTORE DI INFLUENZA DEL CONTROLLO ARTIFICIALE (P) 

Parametro disponibile tra i dati. 

 

https://esdac.jrc.ec.europa.eu/content/soil-erosion-water-rusle2015
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Ottenere il valore di K (erodibilità del suolo) per i suoli del Veneto 

1) Andare nel WebGis ARPAV e visualizzare la Carta dei suoli del Veneto in scala 1:250.000 (per alcune 

aree esiste la carta 1:50.000 https://gaia.arpa.veneto.it/maps/271 

2) Interrogare il poligono scelto, e leggere l’unità cartografica, ad esempio, 

 
3) Aprendo il link sull’unità cartografica, compare una scheda informativa. Nella tabella in basso leggo le 

% con sui questi suoli sono presenti e le loro caratteristiche. Le % di frequenza possono essere usate 

per “ponderare” il seguente valore di K. 

4) Tornando ad interrogare il poligono scelto, scendere fino alla sezione suoli presenti, e aprire le schede 

relative ai singoli poligoni 

  
5) Per ogni suolo si apre una scheda informativa che contiene il fatto re erodibilità del suolo (K) 

utilizzabile per la RUSLE 

 

Valori di C (cover factor) in base al codice di Uso del Suolo Corinne Land Cover 

 

https://gaia.arpa.veneto.it/maps/271
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Per il calcolo: 

1) Importare i 5 layers della RUSLE in QGIS 

 

 
 

2) Calcolo della RUSLE 

a. Raster > Raster calculator e moltiplicare tra loro i 5 fattori 

b. Salvare il file come RUSLE.tif 

c. Come output CRS lasciare 32632 

 
3) FATTO! Ma per comprendere il risultato è necessario tematizzare 
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LEGENDA RUSLE EUROPA: Panagos et al (2015) 

 

a) Tasto dx sul layer > Symbology > Render type: singleband pseudocolor > Discrete > Selezionare una scala 

colori > Mode: Equal (così possiamo scegliere i numero di classi) > Scegliere 8 classi > nella colonna Value 

mettiamo il valore massimo della classe (vedi legenda della RUSLE per l’Europa qui sopra) > nella colonna 

Label mettiamo le classi per esteso (come nella legenda qui sopra) 

b) ATTENZIONE: per una migliore visualizzazione la prima classe <0.5 la mettiamo di colore trasparente 

 
 

c) FATTO! 
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PRODUZIONE CARTOGRAFICA IN QGIS 
Qui impariamo a creare ed esportare una mappa in alta definizione con i dati appena creati. Il procedimento è lo 

stesso indipendentemente da quale mappa vogliamo costruire (erosione, RPII, deflusso, ecc). Per esempio, qui 

mostriamo la mappa del deflusso 

 

1) Adesso andiamo a creare il layout della mappa per poterla esportare: 

 
a) Assegnare il nome layout 1 e click su ok 

b) Ora si è aperto il nuovo layout, ancora vuoto. 

c) Tasto destro nel foglio bianco -> properties -> orientation: landscape 

d) Click sull’icona e disegnare un poligono nel foglio per costruire la mappa: 

 

e)  

f) Attivare l’icona:  
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g) Click sulla mappa -> tasto dx -> item properties e scegliamo la scala:  2500 (questa operazione consente di 

zoomare l’area di lavoro) 

h) Usere questa icona per muovere la mappa ed individuare una zona da mappare: 

 
i) Fatto: 

 
 

Adesso andiamo ad aggiungere la legenda, scala, titolo e freccia del nord: 

 

 

2) Legenda 

a) Add items -> legend -> disegno sulla mappa la legenda 

b) Tasto destro sulla legenda -> items properties 

c) In , togliere la spunta a RESIZE TO FIT CONTENTS 

d) In : 

a. Disattivare auto update, in modo da poter rimuovere tutto ciò che non ci interessa dalla mappa 

usando il simbolo -. 

b. Sempre in Legend Items, posso modificare il nome dei layer da mostrare in legenda: rinominiamo 

il layer della flowaccumulation come DEFLUSSO POTENZIALE, così come per le varie voci in legenda: 
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e) Attivare il bordo attorno alla legenda: 

 
f) Attivare il background (bianco) 

 

FATTO: 

 

 

3) SCALA: 

1. Add items -> Scale bar -> disegno sulla mappa 

2. Selezionando la scale bar, sulla destra appaiono le proprietà. Importante: Selezionare metri come unità di 

misura e m come etichetta. 

 
 

4) FRECCIA DEL NORD: 

1. Add items -> picture -> disegno sulla mappa. In questo modo, si attiva sulla destra ka barra delle prorietà. 

2. In Search Directories seleziono la freccia che mi interessa: 
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3. Fatto:   

 

5) TITOLO: 

1. Add items -> add label -> disegno 

2. Sulla destra, in main properties inserisco il titolo. Utilizzo le altre impostazioni per la formattazione e il 

carattere del testo 

3. Fatto 

 

6) EXPORT TIF (300 dpi) 

1) Sulla barra di destrra: layout -> export settings: imposto 300 dpi 

 
2) Layout -> Export as image -> salvo in .tif 
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